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M1 Tune の使用方法 
M1 Tune のグラフィカルユーザーインターフェースはサイドバーナビゲーションを採用しています。 

サイドバーナビゲーションは、マウスを使った論理的な左から右へのワークフローを提供します。 キーストローク。 

サイドバーはオン・オフの切り替えが可能です。 
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１．FIND 
調整ツリー（Adjust）の検索バーにキーワードを入力すると、該当するパラメータを検索できます。 

以下の例では、キーワード 「idle」 を入力すると、M1 Tune は 

・Adjust ワークスペース内のグループ 

・設定ワークシート内の項目 の両方から「idle」を含むパラメータを検索し、最初に見つかった場所へジャンプします。 

 

Adjust の下にある Firmware（ファームウェア）ヘッダー配下のすべての項目からも「Idle」を検索します。 

※ワークシート内の情報は、Adjust ツリーの下部にある Firmware セクションに表示されます。 
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２．SUMMARY 
概要ページには、ロードされているパッケージに関する以下の情報が表示されます。 

• パッケージバリアント  

• ターゲット ECU のシリアル番号  

• 車両識別情報 

• パッケージバージョンの概要 

• マイグレーション履歴 

• コメント欄およびメモ欄 
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3．RESOURCES 
Resources（リソース）ビューには、ファームウェアのリソース割り当て、設定、I/O モニタリングに必要なすべてのワーク

シートがまとめて表示されます。 

 
Resources ビューは、以下の 4 つのサブビューで構成されています: 

1. I/O Resources view :入出力リソースの割り当て状況を確認・設定するビュー 

2. Details view    :選択したリソースの詳細情報を表示するビュー 

3. I/O Pins view    :ECU の物理ピン（入力／出力）の割り当てと状態を確認するビュー 

4. I/O Monitor view    :I/O のリアルタイム状態を監視するビュー 
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1. I/O Resources 

I/O Resources ワークシートには、各リースの名称、割り当てられたピン名、ピンの用途（Designation）、およびピン

番号が一覧表示されます。 

 
I/O Resources ワークシートでは、表示内容を切り替えることができます。 

• Show All Resources / Show Assigned Only    

ファームウェア内のすべてのリソースを表示するか、割り当て済みのリソースのみを表示するかを切り替えられます。 

• Filter セクション（Ctrl + F）    

リスト内のリソースを素早く検索するために使用できます。 

• Hide / Show Details トグル  

I/O Resources ワークシート下部にある Details（詳細）ビューの表示／非表示を切り替えます。 

 
 

 

2. Details View 

Details View（詳細ビュー）には、Resources ワークシートで選択した各リソースの設定内容が表示されます。 
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3. I/O Pins 

I/O Pins ワークシートは、ECU コネクタのピン配置を図で表示し、どのピンがどの機能に割り当てられているかを示します 
 

注記: 表示される ECU コネクタの図は、パッケージ概要（Summary）に記載されている ECU モデルに対応します 

 
I/O リソースが割り当てられると、該当する ECU ピンがピンアウト図上で色分け表示されます。 

  White :割り当て済みの入力／出力リソースのピン 

  Green   :共通センサー電源（5V）およびセンサー 0V ピン 

  Red   :12V 電源ピン 

  Black   :グラウンド（GND）ピン 

  Orange   :現在選択中のピン 

 

注記: 

• 割り当て済みのピンにマウスカーソルを重ねると、割り当てられているリソース名とピン名が表示されます。 

• グレー表示の未使用ピンにカーソルを重ねると、ピン名のみが表示されます。 

• 白色の入力／出力ピンをクリックすると、対応するリソースが I/O Resources / Details ビューでハイライトされ

ます。 

• 2 つのピンを使用するリソースの場合、両方のピンがオレンジ色でハイライトされます。    

例:Differential Knock Input 1 は D7 と D13 の 2 ピンを使用します。 
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4. I/O monitor 

I/O Monitor ビューでは、上部に割り当て済みリソースと入力／出力値が表示されます。 下部には、選択したリソース
に対応するタイムグラフが表示されます。 
 

Auto（自動）ビューを使用すると、選択したリソースに関連するチャンネルのみが自動的に表示されます。 
 

注記: グラフ上の 緑色の四角（Green rectangles） は、値が急速に変化している箇所を示します。 
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４．FEATURES 
Features ビューは、Engine（エンジン）、Vehicle（車両）、CAN Bus に関する “オン／オフ” や “選択式” の

設定を素早く行うためのワークシートです。 

 

パッケージ内でリソース割り当てが完了すると、Features ビューは ファームウェア内のサブシステムを一元的に有効化／

無効化するための中心的な設定場所 として機能します。 特に、複数のサブシステムが相互に影響する場合に便利で

す。 

 

注記:Features リストに表示される項目はユーザーが追加・編集できるものではありません。 ファームウェア内部の ク

ラスマッチ（Class Match） に基づいて自動的に決定されます。 

 
Features 名をクリックすると、Adjust ビュー内の Configuration Worksheet にある該当リソースへ移動します。 

Features ビュー上部中央には サブシステム切り替えボタンがあり、以下の項目を切り替えて表示できます。 

• CAN Bus Features  

• Engine Features  

• Vehicle Features 
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5．ADJUST 
Adjust ビューは、パッケージ内のすべてのサブシステムおよびパラメータを設定・調整するためのビューです。 

 

Adjust ビューには、以下の最大 5 つのペインが表示される場合があります（例を参照） 

5.1  Adjust Tree     :調整可能な項目を階層構造で表示するツリー 

5.2  Adjust Items    :選択したツリー項目に含まれる調整項目の一覧 

5.3  Adjust Items Editor  :選択した調整項目の値を編集するエディタ 

5.4  Adjust Item Telemetry :選択した項目に関連するテレメトリ（リアルタイム値）を表示 

5.5  Common Telemetry   :複数の項目で共通して使用されるテレメトリを表示 

5.6  Worksheets Overview : 各サブシステムの設定画面 

5.7  Accessing Component Properties:コンポーネントプロパティへのアクセス 

5.8  Channel Abbreviations :チャンネル名の省略設定 

 
  

Adjust Tree 

Adjust Items Adjust Items Editor 

 
Common Telemetry 

Adjust Items Telemetry 
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5.1 Adjust Tree 

Adjust Tree は、画面スペースを確保するために非表示にできます。 上部のトグルボタン で表示／非表示を切り

替えます。 
 
〇Adjust Tree の構成（青いヘッダーで区切られた 3 つのセクション） 

1. Favorites（お気に入り） 

よく使用するパラメータへ素早くアクセスするためのセクションです。 F5 キーで Favorites セクションにジャンプし、再

度押すと Favorites 内の項目を順番に切り替えます。 

追加したいパラメータをドラッグ＆ドロップして Favorites に追加できます。 

注記: パッケージによっては Favorites に項目が存在しない場合があります。 

 

2. Workspace（ワークスペース） 

開いているパッケージに最適化された Adjust グループ構成が設定されています。 Workspace はユーザーがカスタ

マイズできます。 

注記: 各 Workspace は独自の Adjust Tree を持つことができます。 

 

3. Firmware（ファームウェア） 

パッケージ内のすべてのパラメータが、名前順（アルファベット順）にグループ化されて表示されます。 
 
〇Adjust View のナビゲーション 

Adjust View は、マウスまたはキーボードで操作できます。 キーボード操作は速度と精度が大幅に向上します。 

・Adjust グループ内の項目 

・パラメータ 

・ペイン内の項目 

これらのいずれかが オレンジ色でハイライトされている場合、それが 現在のフォーカス項目です。 
 
〇フォーカス項目に応じて変化する UI 

注記:フォーカスされている項目（オレンジ色）に応じて、以下が動的に変化します。 

• Adjust Item Telemetry 

表示されるチャンネルが、現在フォーカスしている項目に合わせて切り替わります。 

• Active Component Toolbar 

フォーカス中のコンポーネントまたはパラメータに応じて、利用可能なツールが変化します。 

• Active Items / Active Item Editor 

現在フォーカスしている項目に応じて、表示内容が切り替わります。 
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下図は、フォーカスされる項目の種類を示した例です。 いずれか 1 種類のみが同時に表示されます。 
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◇方向キー（⇦ ⇨ ⇩ ⇧） 

Adjust Tree 内 

 ⇩ / ⇧:上下に移動 

 ⇨:Adjust グループを展開し、グループ内を順に移動 

 ⇦:1 つ上位のグループ見出しへ移動し、そのグループを折りたたむ 

Configuration（設定）ペイン内 

 ⇩ / ⇧:上下に移動 

Editing（編集）ペイン内 

 ⇦ ⇨ ⇩ ⇧:表形式のセルを自由に移動 

 

◇Enter キー 

Adjust Tree でフォーカス中の項目に Enter を押すと、フォーカスが右側のペインへ移動します。 

（例:Tree → Items → Editor へと進む） 

 

◇Escape キー 

Configuration または Editing ペインで Escape を押すと、フォーカスが左側のペインへ戻ります。 

（例:Editor → Items → Tree へ戻る） 
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◇Find 

Adjust Tree 上部の Find フィールドにキーワードを入力して検索します。 

以下の例では、キーワード temp を入力すると、Tune は Workspace セクション内の Adjust グループを検索し、 

最初に一致した項目へジャンプします。 

また、Tune は Firmware セクション内でも Temperature を含むすべての項目を検索し、該当箇所を一覧に表

示します。 
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5.２ Adjust Items 
Adjust Items には、Adjust Tree で選択した項目に関連するすべてのパラメータ、チャンネル、テーブルが表示されま

す。 テーブル以外のパラメータは、このペイン内で編集できます。 

 

注記: アイコンが付いた項目はテーブルを示します。 一部のテーブルは軸が設定されていないため、単一セルのテーブ

ル（1×1）として表示されます。 これらは Adjust Item Editor で単一の数値として編集する必要があります。 

 

5.３ Adjust Items Editor 
◇Adjust Items Editor（エディタ） 

エディタは、Adjust グループやパラメータを設定するためのタッチ操作対応コントロールを提供します。  
 
◇ Configuration Worksheet（設定ワークシート） 

Adjust Items Editor を使用して、テーブル軸の設定、セル値の変更、パラメータ値の編集を行います。 
 
◇ I/O Resources Worksheet（I/O リソース ワークシート） 

割り当て済みのリソースを表示し、必要に応じて再割り当てを行うことができます。 
 
◇ Custom Worksheets（カスタムワークシート） 

カスタムワークシートを作成できます。 ワークシートバナー上で右クリックして「New Worksheet」を選択するか、 右上

の ボタンをクリックします。 

 

5.4 Adjust Items Telemetry 
◇All Channels Worksheet（全チャンネル ワークシート） 

上部には、ECU とオンライン接続時のライブチャンネルデータが表示されます。 下部には、選択したチャンネルのタイムグ

ラフが表示されます。 
• 上部の検索フィールドで、キーワードを含むチャンネルを素早く検索できます。 

• Show Hidden Channels トグル を使用すると、ファームウェア内のすべてのチャンネル、または設定に関連する

チャンネルのみ を切り替えて表示できます。 
• チャンネルを ダブルクリックすると、Channel Properties（チャンネルプロパティ） ダイアログが開きます。 

 
◇Auto Worksheet（自動ワークシート） 

Auto ワークシートは 3 つのセクションで構成されています。 
1. 上部セクション 

Adjust Tree の選択に関係なく常に表示されるチャンネルが含まれます。 右クリックで Time Graph Properties を
開き、チャンネルの追加・削除・編集ができます。 
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2. 中央セクション 
Adjust Tree で選択した Adjust グループに関連するチャンネルが表示されます。 右クリックで Time Graph 
Properties を開き、チャンネルの追加・削除・編集ができます。 

 
3. 下部セクション（Status Grid） 

ステータス表示に適したチャンネルをグリッド形式で表示します。 右クリックで Status Grid ダイアログを開き、チャンネ

ルの追加・削除・編集ができます。 
 
◇Custom Worksheets（カスタムワークシート） 

カスタムワークシートを作成できます。 ワークシートバナーを右クリックして「New Worksheet」を選択するか、 右上の

ボタンをクリックします。 
 

5.5 Common Telemetry 
◇Common Telemetry（共通テレメトリ）セクション 

Common Telemetry セクションには、他の選択内容に関係なく常に表示される ECU テレメトリデータが表示されま

す。 このセクションは必要に応じてカスタマイズできます。 
 
◇ Custom Worksheets（カスタムワークシート） 

カスタムワークシートは自由に構成できます。 ワークシートバナーを右クリックして「New Worksheet」を選択するか、 右

上の ボタンをクリックして作成します。 
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5.6 Worksheet Overview 
Adjust ビューには複数のワークシートが用意されており、これらは ECU の設定およびチューニングを行うために使用され

ます。 ワークシートは、Adjust Items Editor の上部に配置されています。 

 
ワークシートには 2 種類あります: 

1. Configuration Worksheet（設定ワークシート） 

   このワークシートはロックされており、すべての Workspace に必ず表示されます。 

2. ユーザー定義ワークシート 

    多くの Workspace には、特定の作業目的に合わせて事前構成されたワークシートが含まれています。 

これらはユーザーが自由に編集・追加できます。 

 

◇Worksheet の作成と編集 

新しいワークシートは空の状態で作成されます。 ユーザーは、用途に合わせて任意のコンポーネントを配置し、自由に

レイアウトを構築できます。 

配置したコンポーネントは、移動・サイズ変更・カスタマイズが可能で、 ワークシートの目的に合わせて最適な構成に調

整できます。 
 
◇コンポーネントとプロパティ 

各コンポーネントには、その種類に固有のプロパティがあり、 これらのプロパティがコンポーネントの外観と動作を決定し

ます。 

プロパティ値は M1 Tune 内で設定され、M1 ECU のチューニングに使用されます。 

＜注意点＞ 

同じ種類のコンポーネントを複数のワークシートで使用できますが、 各コンポーネントのプロパティは“そのインスタンス専

用”であり、 他のワークシートの同種コンポーネントとは共有されません。 
 
◇新しい Worksheet の作成方法 

ワークシートバナーを右クリックして「New Worksheet」を選択するか、 右上のボタンを クリックして新規作成しま

す。 作成後、ワークシート名を入力します。 

既存のワークシートを編集する場合も、ワークシートバナーを右クリックします。 
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新しいワークシートを構成するには、ワークシートの背景部分を右クリックし、表示されるダイアログから追加したいコンポーネント

を選択します。 

 
  

 

［ゲージタイプのコンポーネントの例］ 利用可能なコンポーネントには、以下の種類があります 

 Calibrate（キャリブレート） 

 Table Target（テーブルターゲット） 

 Channel List（チャンネルリスト） 

 Time Graph（タイムグラフ） 

 Scatter Plot（散布図） 

 Histogram（ヒストグラム） 

 Colour Graph（カラーグラフ） 

 Notes（ノート） 

 Gauges（ゲージ） 
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5.7  Accessing Component Properties 
個々のコンポーネントのプロパティを編集するには、以下のいずれかの方法を使用します。 

 コンポーネントを選択して F5 を押す 

 コンポーネントを 右クリック → Properties... を選択する 

すると、そのコンポーネントに対応した プロパティウィンドウ が表示されます。 （例:Time Graph コンポーネントのプ

ロパティウィンドウ） 
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◇Table Target コンポーネント 

Table Target コンポーネントは、エンジンチューニング時によく使用される表示コンポーネントです。 コンポーネント全

体が 現在選択されているテーブル を表し、 赤いフローティングスクエア は、ライブチャンネル値がテーブル上のどの位

置にあるかを示します。 

これにより、現在の動作点がテーブルのどのセルに相当するかをリアルタイムで把握できます。 

 

＜Table Target の表示切り替え＞ 

Table Target コンポーネントは、Items ペイン内で以下の操作により表示のオン／オフを切り替えられます 

・ Shift + T 

・ Active Item Toolbar の「Show Target View」ボタン 

           
 

＜ダイノでの Table Target の一般的な使い方＞ 

Table Target コンポーネントは、ダイノでエンジンをチューニングする際に最もよく使用されます。 チューナーはま

ず 調整したいテーブルのサイト（セル）を選択します。 

その後、スロットルや負荷を調整して、 赤いスクエア（ライブ値）が Table Target の中央に来るようにエン

ジンを操作します。 

赤いスクエアが中央に位置するということは、 エンジンのライブ値が、選択したサイトの軸値と一致している こと

を意味します。 

 

ライブ値とサイトが一致した後の動作 

エンジンのライブ値と選択したサイトが一致すると、 そのサイトの値を変更した際、変更内容がリアルタイムでエン

ジンの動作に反映されます。 

 選択したセルの値を上げる → エンジンの動作も即座に変化 

 選択したセルの値を下げる → 同様にリアルタイムで反映 
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◇Channel List コンポーネント 

Channel List コンポーネントは、チャンネルをフィルタリングおよびソートした一覧と、そのライブ値を表示します。 

 

     チャンネルリストの例 

      
 

＜Channel List のフィルタと検索＞ 

Channel List は、Channels Properties ウィンドウと検索バーを使ってフィルタリングできます。 

検索バーが表示されていない場合は、 Channels Properties ウィンドウの「Display」タブで表示を有効化

できます。 

 

＜Channels Properties ウィンドウで設定できる項目＞ 

Channels Properties ウィンドウでは、以下の設定を行えます: 

 表示するチャンネルの選択 

 コンポーネントのキャプション（タイトル） 

 コンテキストヘルプの表示有無と表示位置（左／右） 

 検索ツールバーの表示／非表示 

 

注意点 

Channel List はライブ値を表示するためのコンポーネントであり、 表示される値そのものを編集することは

できません。 
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◇Time Graph コンポーネント 

Time Graph コンポーネントは、選択したチャンネルのライブ値を時系列で追跡し、グラフとして表示します。 

 

Time Graph 例 

 
 

＜Time Graph の軸構成＞ 
Time Graph は、X 軸に時間、Y 軸に各チャンネルグループの値の範囲を使用して表示されます。 

 
＜Time Graph の一時停止と再開＞ 

Time Graph は、キーストローク A を押すことで一時停止および再開できます。  

 

＜Time Graph Properties で設定できる項目＞ 

Time Graph Properties ウィンドウでは、以下の設定を行えます: 

 コンポーネントのキャプション（タイトル） 

 表示するチャンネルグループおよびチャンネルの追加・削除 

 チャンネルグループおよびチャンネルの表示順序 

 チャンネルのレイアウト（重ね表示・分割表示など） 

 軸情報、レンジ、単位などの表示オプション 

 グラフに表示する時間範囲およびその他のテレメトリ設定 
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◇Live Data Control（ライブデータ制御） 

M1 Tune は、ECU から送られてくるライブデータをリアルタイムで表示できます。 ライブ値は、チャート・グラフ・ゲージ

などのコンポーネントを通じて視覚化され、 エンジンの動作状態をその場で監視できます。 

 

＜過去のイベントを確認する場合＞ 

ライブデータ表示中に、過去に発生したイベントを遡って確認したい場合は、 Time Graph コンポーネントを使用し

ます。 

Pause（T キー）でライブ表示を停止 

メニューツールバーの Pause ボタン  または T キーを押すと、 ライブ表示が一時停止します。 

※録画（データの受信）は継続しますが、画面更新は止まります。 

 

Pause 中の挙動 

Pause 状態になると、 

 「Connected」アイコンが点滅（  ） 

 すべてのコンポーネントの値表示が停止 

これにより、その瞬間の状態を固定して解析できます。 

 

＜過去のデータを解析する＞ 

Pause 後、Time Graph 上でカーソルを移動すると、 その時点のデータがすべてのコンポーネントに反映されま

す。i2 と同様に、ズームイン／ズームアウトして詳細を確認できます。 
 
チューニング作業での活用例 

Pause 機能はエンジンチューニング時に非常に有効です。 

例えば、エンジンをレンジ全体にわたって回した後、 Pause を使ってライブ表示を止めることで、 そのラン中の任意の

時点に遡って詳細に解析できます。 
 
Pause の解除 

Pause ボタンまたは T キーで Pause を解除すると、 すべてのコンポーネントが再びライブ表示に戻り、 Time 

Graph もリアルタイム更新に復帰します。 
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◇Scatter Plot コンポーネント 

Scatter Plot コンポーネントは、2 つの関連するチャンネルの関係性をリアルタイムでプロットし、トレンドを視覚化す

るためのコンポーネントです。 

 

よくある使用例 

このタイプのチャートは、以下のような 2 変数の相関を確認する用途でよく使われます: 

 ブースト圧と RPM の関係 

  油温に対する油圧の変化 

これにより、エンジンの動作特性や異常傾向を直感的に把握できます。 

 

Scatter Plot 例 

 
Scatter Plot のサンプリング動作 

Scatter Plot は、選択された 2 つのチャンネルを 50 Hz でサンプリングし、 その時点の 2 つの値の交点をプロットし

ます。プロットされた点は、設定された保持時間の間、画面上に残ります。 
 
 Scatter Plot Properties で設定できる項目 

Scatter Plot Properties ウィンドウでは、以下の設定を行えます: 

 チャンネルの選択と設定 

 各種表示オプション 

 プロットを保持する時間（Telemetry タブで設定） 
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◇Histogram コンポーネント 

Histogram コンポーネントは、特定のチャンネルが“どの値の範囲にどれだけの時間滞在したか”をグラフで表すコン

ポーネントです。 

例えば、エンジンが高ブースト領域にどれだけの時間いたか を視覚的に確認できます。 
 

使用例 

一般的な例として、 エンジンが各 RPM 範囲にどれだけの時間滞在したかを示すヒストグラム がよく使われます。 

 
Histogram Properties ウィンドウでは、以下の設定を行えます: 

 チャンネルの選択と設定 

 各種表示オプション 

 ヒストグラムを表示する期間（Telemetry タブで設定） 
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◇Colour Graph コンポーネント 

Colour Graph コンポーネントは、チャンネルの値の変化を“色”で表現し、時間軸に沿って表示するコンポーネント

です。 

値が変化すると色も変化するため、 温度・負荷・圧力などの推移を視覚的に把握しやすい という特徴があります。 
 

使用例 

下の例では、エンジン温度の Colour Graph を示しています。 エンジンが 

 冷間始動 

 昇温 

 冷却  

といった状態を、色の変化として確認できます。 

 
 Colour Graph の活用例 

Colour Graph は、複数の排気温度（EGT）など、同種のチャンネルを比較する際に非常に有効です。 

全シリンダーの EGT を同じ Colour Graph 上に表示すると、 各シリンダーがどのような速度で温度上昇しているか

を色の変化で比較できます。 

これにより、 

 どのシリンダーが早く温度上昇しているか 

 どのシリンダーが遅れているか 

 異常な温度挙動があるか 

といった傾向を直感的に把握できます。 

 

Colour Graph Properties で設定できる項目 

Colour Graph Properties ウィンドウでは、以下の設定を行えます: 

 チャンネルの選択と設定 

 各種表示オプション 

 タイムラインの進行速度（Telemetry タブで設定） 
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◇Notes コンポーネント 

Notes コンポーネントは、Worksheet に関する情報を記述するためのメモ機能です。 これはアプリケーション開発

者だけでなく、エンドユーザーも利用できます。 

 

Notes は「Worksheet 固有」であることが重要 

同じ Notes コンポーネントが複数の Package で使用される可能性があるため、 Notes の内容は Package で

はなく Worksheet に紐づけて記述する必要があります。 

 

アプリケーション開発者による利用 

開発者が Package 用に標準化された Worksheet を作成する際、 Notes を使ってその Worksheet に関す

る説明や使用方法をエンドユーザーに提供できます。 

標準化された Worksheet は Package ごとに構成されるため、 Notes の内容も アプリケーションに合わせて最

適化できます。 

 

エンドユーザーによる利用 

エンドユーザーが独自のカスタム Worksheet を作成する際にも、 Notes は非常に有用です。 

主な用途は以下のとおりです: 

 Worksheet の使い方を説明する 

 各コンポーネントの目的を記述する 

 チューニング時の注意点や手順をメモする 

 作業ログや設定意図を残す 
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◇Gauges コンポーネント 

Gauges コンポーネントは、チャンネル値を“素早く・直感的に”読み取るための表示コンポーネントです。 

エンジンが稼働している状況では、 重要なエンジン状態を一目で把握できることが極めて重要であり、 Gauge は

そのための最速の可視化手段となります。 

 

 

 

 

  

Numeric Gauge（数値ゲージ） 

単一のチャンネル値を、数値としてシンプ

ルに表示するゲージです。 

 

 

 

・現在値を大きく明確な数字で表示 

・単位（°C、kPa、rpm など）を併記
可能 

・色分け（正常／注意／警告）で状
態を強調できる 

・画面スペースを比較的取らず、複数並
べて配置しやすい 

・針の動きよりも 絶対値の把握が重要
なチャンネル に向く 

 

Bar（バーゲージ） 

Bar Gauge は、チャンネル値を縦また

は横方向のカラー付きバーで表示するゲ

ージです。 

 

 

・縦または横のバー表示に対応 

・値の増減がバーの⾧さと色で直感的に 
分かる 

・色分け（正常／注意／警告）により
状態を強調 

・変化の傾向を視覚的に把握しやすい 

・数値よりも “どれくらいの割合か” を素
早く確認したい場合に最適 

 

Dial（ダイアルゲージ） 

針が動く“ダイヤル式”のゲージで、チャン

ネル値をアナログメーターとして表示しま

す。 

 

 

・針の動きで 値の増減や傾向を直感
的に把握できる 

・実車のメーターに近い表示で、視認性
が高い 

・正常域・注意域・危険域を 色分け し
て表示可能 

・動きの速いチャンネルでも視覚的に追
いやすい 

・レイアウト上の存在感があり、重要チャ
ンネルに向く 

 

Status Light（状態表示） 

特定のチャンネル値や条件に応じて点

灯する、警告灯／ステータスライト型の

ゲージです。 

 

 

・条件を満たすと 色付きのライトが点灯 

・正常／注意／警告などを 色で即座
に判断できる 

・数値を読む必要がなく、視界の端でも
異常に気づきやすい 

・設定した閾値や条件に基づいて自動
で点灯・消灯 

・重要チャンネルの安全監視に最適 
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◇Table Slice コンポーネント 

Table Slice コンポーネントは、テーブルデータの一部を“視覚的に切り出して表示する”ためのデータ可視化コンポー

ネントです。 

 

Table Slice View のオン／オフ 

Table Slice View は、アクティブコンポーネントのツールバー から On / Off を切り替えできます。 

必要なときだけ表示し、不要なときは非表示にできるため、Worksheet の視認性を保ちながら利用できます。 

 

色のルール 

Table Slice の色は、割り当てられたチャンネルカラーによって決まります。 

つまり、チャンネルごとに設定された色がそのまま Table Slice に反映され、 値の変化や領域の違いを視覚的に把

握しやすくなります。 

 
          Inactive Table Slices（非アクティブスライス）は、表示のオン／オフを切り替えたり、透明度を調整できます。 

これらの設定は、 Tools > Options > Tables から行います。 
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◇Map Trails コンポーネント 

Map Trails コンポーネントは、エンジンがテーブル上のどの領域で動作しているかを“軌跡（Trail）として可視化す

る”ためのコンポーネントです。

 
Map Trails コンポーネントは、スタイル（表示形式）と軌跡の保持時間（Trace Duration）を設定できます。 

これらの設定は、 Tools > Options > Tables から行います。 
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◇Status Grid コンポーネント 

Status Grid コンポーネントは、チャンネル値を数値またはテキスト形式で直感的に表示するためのコンポーネントで

す。数値チャンネルや診断チャンネルには Fault Limit（異常閾値） を設定でき、 ユーザーの好みに応じて 色を

変えて状態を分かりやすく表示できます。 
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5.8 Channel Abbreviations（チャンネル名の省略設定） 
ユーザーは、チャンネル名の省略方法を選択できます。 

省略名を使用すると、画面上の占有スペースが減り、ノート PC などの小さな画面でも視認性が向上します。 

 
＜辞書の切り替え方法＞ 

画面右下を右クリックすると、辞書（Dictionary）を切り替えることができます。 

      
 

略語の例 

 

  
Firmware MoTeC AUTOSAR 
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MoTeC 辞書および AUTOSAR 辞書の省略一覧は、 Tools > Show Abbreviations... を選択することで確認で

きます。 

 

  
MoTeC 

 

AUTOSAR 
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６．LOGGING 
M1 のロギング機能は高度な設定が可能で、シンプルな単一ユーザー環境から、厳格に管理されたカテゴリー規定にも

対応できる柔軟性を備えています。 

M1 には 8 つの独立したロギングシステム が用意されており、用途に応じて使い分けることができます。 
 
ユーザー／ロール別のログ管理 

M1 のロギングはユーザーやロール（役割）ごとに表示データを分けることができます。 

例えば: 

 チューナー（Tuner） :詳細なエンジンデータ 

 車検担当（Scrutineer） :規定確認用の限定データ 

 シャシーエンジニア  :車両挙動に関するデータ 

これらは 重複してもよいし、完全に分離することも可能です。 
 
アクセス制御とセキュリティ 

各ユーザーは、自分がアクセスできるログ設定のみを確認・編集できるように個別に保護できます。 

これにより: 

 不要なデータへのアクセスを防止 

 カテゴリー規定に沿った 厳密に分離されたロギング構成 を実現 

 チーム内の役割に応じたデータ管理が可能 
 
 
シンプルな構成も可能 

より簡易的な運用を求める場合、 単一のログ設定を使用し、全メモリを共有し、セキュリティなし という構成も選択でき

ます。これは、個人ユーザーや小規模チームに適した設定です。 
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M1 のロギング設定画面は、次の 3 つのセクションで構成されています。 

1. Available Items セクション 

ログに追加可能な項目（チャンネル、パラメータ、リソース）が一覧表示されます。 

 ログ対象にできるすべての項目がここに表示 

 検索やフィルタで目的のチャンネルを素早く選択 

 必要な項目をドラッグして Logged Items に追加する構成 

 

2. Logged Items セクション 

現在ログに記録される項目の一覧です。 デフォルトでは、必要な診断チャンネル（Diagnostic Channels）が自動

的に含まれています。 

 ログ対象として選択されたチャンネルがここに並ぶ 

 ログレート（サンプリングレート）や条件を個別に設定可能 

 不要な項目はここから削除できる 

 カテゴリー規定に合わせたログ構成もここで管理 

 

3. Properties セクション 

スライダー形式の設定項目と Logging Statistics（ロギング統計）が表示されます。  

詳細は Logging Statistics セクションを参照 

 ログレートや条件の設定をスライダーで調整 

 メモリ使用量やログ時間などの統計情報を確認 

 ログシステムごとの容量配分を把握しやすい 

 

Logging View Active Component Tool Bar 

 
 

Logging System selection 

表示する Logging System（1～8）を選択できます。 

M1 Tune を起動すると、通常は Normal（標準）ログシステム が自動的に読み込まれます。 その他のログシステム

は、必要に応じてユーザーが個別に設定します。詳細は Logging Configuration を参照してください。 
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6.1 LOGGING FEATURES 

M1 のロギングシステムには、柔軟な運用と厳格なカテゴリー規定の両方に対応するための、次の高度な機能が備わっ

ています。 

 

1. 8 系統の独立したログシステム 

 8 つのログセットを完全に独立して構成可能 

 チーム内の役割やカテゴリー規定に応じて使い分けられる 

 

2. ユーザーセキュリティとの強固な統合 

 ユーザーが閲覧権限を持つログのみダウンロード・変換可能 

 権限のないログデータは一切アクセス不可 

 カテゴリー規定に沿った厳密なデータ管理が可能 

 

3. ダウンロードは可能だが、変換は制限可能 

 特定ユーザーは → ログの ダウンロードのみ許可 → ログの 変換（.ld → .ldx など）は禁止 

 Scrutineer（車検担当）向けの制限に最適 

 

4. 制限付きログセットの閲覧制御 

 ログセットごとにアクセス権を設定 

 ユーザーは 自分が許可されたログセットのみ 閲覧可能 

 ロール別のデータ分離を厳密に実現 

 

5. ログセットごとのメモリ予約（Reserved Memory Allocation） 

 各ログシステムに専用メモリ領域を割り当て可能 

 重要ログが他のログに圧迫されることを防止 

 カテゴリー規定で必要な「固定メモリ割り当て」に対応 

 

6. Cyclic Logging（循環ロギング） 

 メモリがいっぱいになると古いデータから上書き 

 ⾧時間の走行や耐久レースに最適 

 メモリ不足によるログ停止を防ぐ 

 

  



 

 

Page  38  

 

 

7. ログ開始／停止条件の設定（Start / Stop Parameters） 

 エンジン回転数 

 スロットル開度 

 車速 

 スイッチ入力 など、任意の条件でログ開始／停止を自動化できる 

8. ログレート（サンプリングレート）の選択 

 チャンネルごとにログレートを設定可能 

 高速変化チャンネルは高レート 

 温度系などは低レート → メモリ効率を最適化 
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6.2 LOGGING CONFIGRATION 

Moving Items（ログ項目の移動） 
M1 ロギングシステムを構成するには、Available Items セクションから必要な項目を選択し、Logged Items セク

ションへ移動します。 

＜操作の流れ＞ 

 Available Items ログに追加可能なチャンネル・パラメータ・リソースが一覧表示される 

 Logged Items 実際にログへ記録される項目のリスト 

設定手順はシンプルで、 Available Items → Logged Items の順に項目を移動するだけ。 
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Adding Items to Logging（ログ項目の追加） 

Available Items から Logged Items へ項目を移動する方法は複数あります。 

1. ドラッグ＆ドロップ（デフォルトレート） 

Available Items から Logged Items にドラッグ＆ドロップすると、デフォルトのログレートで追加されます。 

2. ダブルクリック（デフォルトレート） 

Available Items の項目をダブルクリックすると、Logged Items に追加され、デフォルトレートが適用されます。 

3. ドラッグ → ログレートボタンにドロップ 

Available Items から項目をドラッグし、任意のログレートボタン上でドロップすると、そのレートで追加されます。 

4. Auto ボタン（デフォルトレート） 

項目を選択して Auto をクリックすると、Logged Items に追加され、デフォルトレートが適用されます。 

5. ログレートボタンをクリックして追加 

項目を選択して任意のログレートボタンをクリックすると、そのレートで Logged Items に追加されます。 
 
Notes（補足） 

 すべての操作は単一項目でも複数項目でも実行可能 

 デフォルトログレートは Auto と同じレート 

 デフォルトレートは項目の最大レートとは限らない 

 デフォルトレートは Firmware Package Author によって定義される 

 

  

Auto ボタン 

ハイライトされている項目を、デフォルトのログレートで Logged Items に追加します。 

 Available Items で項目を選択 

 Auto をクリック → 即座に Logged Items に追加され、標準ログレートが自動適用される 

 大量の項目を素早く追加したいときに便利 

Logging Rate ボタン 

選択した項目に対して、任意のログレート（サンプリングレート）を割り当てます。 

 例:1 ms、10 ms、20 ms、100 ms など 

 高速変化チャンネル（RPM、TPS、MAP）は高レート 

 温度系など変化の遅いチャンネルは低レート → メモリ効率を最適化できる 

Remove ボタン 

ハイライトされている項目を Logged Items から削除します。 

 ログ対象から外したい項目を選択 

 Remove をクリック → 即座にログ対象外になる 

 不要なログを削減し、メモリ使用量を抑えるのに有効 
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Removing Items from Logging（ログ項目の削除） 

Logged Items から Available Items へ戻す方法も複数あります。 

1. ドラッグ＆ドロップ 

Logged Items から Available Items にドラッグすると削除されます。 

2. ダブルクリック 

Logged Items の項目をダブルクリックすると Available Items に戻ります。 

3. Remove ボタン 

項目を選択して Remove をクリックすると、Available Items に戻ります。 
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Moving System 
M1 のロギングは、単一ユーザー向けの簡易構成から、厳格なカテゴリー規定に対応する複雑な構成まで柔軟に設定

できます。そのために、M1 には 8 つの独立したログシステム が用意されています。 

 

Create a Logging System（ログシステムの作成） 

以下は System 2～System 8 のログシステムを新規に構成する手順です。 

 

1. ログシステムを選択 

Logging System 2～8 のいずれかを選択します。 

System 1（Normal）は M1 Tune 起動時に自動ロードされるため、 追加のログセットは System 2 以降で構

成します。

 
 

2. Enable（有効化） 

Enable スライダースイッチをクリックしてログシステムを有効化します。 

有効化すると、そのログシステムに対して設定が可能になります。 

 

3. Active Condition（アクティブ条件）の設定 

Active Condition  を選択し、一覧から条件となる項目を指定します。 

例: 

 Engine Speed > 500 rpm 

 Vehicle Speed > 5 km/h 

 Switch Input = On 

この条件が満たされたときにログシステムが動作します。 

 

4. ログ項目の追加 

Available Items から必要な項目を選択し、Logged Items に移動します。 

移動方法は以下のいずれでも可: 

 ドラッグ＆ドロップ 

 ダブルクリック 

 Auto ボタン 

 ログレートボタンを使って追加 

（詳細は前セクションの「Adding Items to Logging」を参照） 
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Include ECU Messages 

オンにすると、ログ取得時に ECU メッセージがノート PC へ保

存されます。 

 ECU 内部の診断メッセージやステータス情報を含めら

れる 

 トラブルシュート時に有効 

 通常ログとは別の情報系統を補完する役割 
 
Include Parameters 

オンにすると、パラメータが Available Items セクションに追

加されます。 

 通常はチャンネルのみが対象 

 これをオンにすると、パラメータ値もログ対象にできる 

 キャリブレーション値の変化を追跡したい場合に便利 
 
Cycle Memory（循環メモリ） 

オンにすると、メモリが満杯になった際に先頭からデータを上書

きします。 オフの場合、メモリが満杯になるとロギングは停止し

ます。 

 耐久レースや⾧時間走行では オン が一般的 

 重要イベントを確実に残したい場合は オフ にすること

もある 

 メモリ管理の基本設定として重要 
 
Reserve Memory（メモリ予約） 

オンにすると、ログシステムごとに予約メモリ量を調整できます。 

スライダーを使って各ログシステムのメモリ割り当てを設定しま

す。 

 8 系統のログシステムを使い分ける際に必須 

 重要ログが他のログに圧迫されるのを防ぐ 

 カテゴリー規定で「特定ログに固定メモリを割り当てる」

必要がある場合に対応 
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6.3 REPAIR LOGGING SYSTEM 

M1 Tune には、削除できない「必須診断チャンネル」が存在します。 これらのチャンネルには 専用アイコン  が表示

されます。 

 ECU の正常動作を保証するために必須 

 ログセットから削除することはできない 

 Firmware Package Author によって定義されており、M1 Tune 側で編集不可 
 
Maximum Logging Rate（最大ログレート） 

すべてのチャンネルには、チャンネル固有の最大ログレートが設定されています。 

 最大レートを超える設定で Logged Items に追加すると→ そのチャンネルは Fault（エラー）状態 になります 

 ログレートはメモリ使用量とログ時間に直結するため → 適切なレート設定が重要 
 
Repair Log Systems（ログシステム修復） 

Active Component Tool Bar にある Repair Log Systems ボタン は、 ログ構成の整合性を自動的に修復

するための機能です。 
 
Repair Log Systems が行う 2 つの処理 

1. 必須診断チャンネルの復元 

削除された、または欠落している必須診断チャンネルを自動的に復元します。 

 誤って削除した場合でもワンクリックで修復 

 カテゴリー規定に沿ったログ構成を維持できる 

2. 最大ログレート超過の修正 

最大ログレートを超えているチャンネル、または無効なレートで設定されているチャンネルを自動的に再スケジュールし

ます。 

 Fault 状態のチャンネルを正常化 

 ログ構成の整合性を確保 

 大規模ログセットの管理に非常に有効 
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6.4 RETRIEVE LOGGING DATA 

M1 ECU に保存されたログデータは、MoTeC i2 Data Analysis ソフトウェアで閲覧するために取得できます。 
 
ログデータの取得手順 

1. Retrieve Logged Data を実行 

次のいずれかの方法でログ取得を開始します: 

 アプリケーションツールバーの Retrieve Logged Data ボタン をクリック 

 Ctrl + F8 

 Online > Retrieve Logged Data を選択 

 

2. ログシステムを選択 

取得したい Data Logging System（1～8）を選択します。 

 System 1（Normal） 

 System 2～8（ユーザーが構成したログセット） 
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3. 保存先を指定 

ログファイルの保存場所を選択します。 

 任意のフォルダを指定 

 保存後、MoTeC i2 で開いて解析可能 

        
 

４. 必要な項目を入力したら、Next を選択します。ログデータの取得が開始されます。 
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取得した Logged Data Image を、i2 で閲覧可能なログファイル形式へ変換するには、このボタンを選択します。 

 

変換の役割 

 M1 ECU から取得されるのは Logged Data Image（生データ） 

 そのままでは i2 で開けない 

 Convert を実行すると、 → i2 で解析可能な ログファイル（.ld / .ldx など） に変換される 
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6.５ LOGGING STATISTICS 

Logging Statistics を使用すると、ログシステムの構成を最適化するための重要な情報を確認できます。 グラフを参

考に、ログレートやログ項目数を調整し、メモリ効率とログ時間をバランス良く設定できます。 

 
 

 
Total Throughput（総スループット） 

ログメモリに書き込まれているデータ量の合計を示します。 

 ログレートが高いほどスループットは増加 

  スループットが大きいほどログ時間は短くなる 

  ログ構成の負荷を把握する指標 

 

Memory Usage（メモリ使用量） 

各 Logging System に割り当てられたメモリ量を示します。 必要に応じて Reserve Memory スイッチで調整でき

ます。 

  ログシステムごとのメモリ配分を視覚的に確認 

  重要ログに十分なメモリを確保する際に使用 

  複数ログシステム運用時の必須指標 
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Channel Usage（チャンネル使用率） 

パッケージ内で利用可能なチャンネル数に対して、どれだけ使用しているかを示します。 

  使用率が高いほどログ負荷が増加 

  不要なチャンネルを削除する判断材料になる 

  パッケージの限界に近づいていないか確認できる 
 
Log Rate Distribution（ログレート分布） 

各ログレートに割当てられているチャンネル数を棒グラフで表示します。 

カーソルを重ねるとそのレートに割り当てられているチャンネル数が表示されます。 

 

カラムをクリックすると 

Logged Items がフィルタされ、そのレートでログされているチャンネルのみが表示されます。 

  高レートに偏りすぎていないか確認メ 

  モリ効率改善のための調整が容易 

 ログレート最適化のための強力な可視化ツール 
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７．ZERO 
Zero View は、“Q（Quick Calibrate）機能” が割り当てられた項目だけを自動的に集約し、ワンタッチでゼロ点

合わせを行える専用ビューです。 
 
Zero View の役割 

 “Q” 機能を持つセンサー／リソースが 自動で一覧に集まる 

 大きなタッチボタンで Quick Calibrate を即実行 

 選択した項目に応じて → Time Graph（時系列グラフ） → Status Grid（ステータス表示） が 自動更新 
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８．STATUS 
Status View は、Firmware 内に存在するすべての診断チャンネルをステータスグリッドとして一覧表示するビューで

す。 

 

自動グルーピング 

 診断チャンネルは 自動的にグループ分けされて表示される 

 4 項目を超えるグループ は、画面上部に独立したタブ として表示 

 グループに属さない項目は Misc（その他）タブ にまとめられる 

 

Status View の表示方法 

 F3 キー 

 または Side Bar Navigation の Status タブ 

どちらでも Status View を開ける。 

 

表示制御（注意点） 

Subsystem が “Not in use” の場合、その診断チャンネル／ステータスグリッドは非表示になることがあります。 

 

Time Graph（時系列グラフ）との連動 

任意のステータスグリッドをクリックすると、その診断チャンネルが画面下部の Time Graph に表示されます。 

 選択した診断チャンネルの 電源投入後の履歴 を確認できる 

 センサー異常や断線、値の揺れなどを即座に把握可能 

 

Status Event Log（ステータスイベントログ） 

Show Status Event Log ダイアログを開くには、専用ボタン  を選択します。 

 診断イベントの履歴を確認 

 Fault の発生タイミングや継続時間を把握できる 
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例:Gear グループが選択されている場合 

以下のような動作になる: 

 Gear グループ がタブとして選択されている 

 Gear Posn Sensor Main Diag が選択され、オレンジ色でハイライト 

 その診断チャンネルが Time Graph に表示 

 F1 を押すとヘルプが開き、 → 列挙値（Enumerations） → Fault 条件 が確認できる 
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９．ALARMS 
Alarm View は、ECU とオンライン接続中に発生しているアクティブアラームを一覧表示するビューです。 Shift + F3 

で開くことができます。 

 

アラーム設定の保存先 

アラーム設定は ECU ではなく、接続している PC の Workspace に保存されます。 

 ECU を変えても Workspace が同じなら設定は維持 

 チーム内で Workspace を共有する場合は設定も共有される 

 

右側の操作ボタン 

Alarm View の右側には次の操作ボタンがあります: 

 Alarms Event Log の表示 → 過去のアラーム履歴を確認 

 Edit Alarms（アラーム設定の編集） → 発生条件や表示方法を調整 

 Acknowledge All（すべてのアラームを確認済みにする） → 現在のアクティブアラームを一括で承認 

 

ショートカットキー 

 K キー → すべてのアラームを一括で Acknowledge（確認済み）にする 

 

個別アラームの操作 

各アラームには専用ボタンがあり、個別に操作できます: 

  Acknowledge → このアラームだけを確認済みにする 

  Ignore → このアラームを 現在のセッション中だけ無視する（ECU 再接続や再起動でリセットされる） 
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9.1 ALARM SETUP,CREATION AND EDITING（アラーム設定・作成・編集） 
アラームは Tools > Edit Alarms… から、または Alarm View 右側の Edit Alarms アイコン から管理・作成・

編集できます。 

 

◇Alarm Setup（アラーム設定） 
基本動作 

Alarm Setup ウィンドウのチェックボックス  

 オン:アラーム有効  

 オフ:アラーム無効（評価されず、発生しない） 

この動作は Create an Alarm / Edit an Alarm ウィンドウの Enable チェックボックスも同じ。 

 

Alarm Setup でできること 

 Add  :新しいアラームを作成（Create an Alarm ウィンドウが開く） 

 Edit  :既存アラームを編集（ダブルクリックでも可） 

     Alarm View で 発生中のアラームをダブルクリック しても Edit 画面が開く 

 Remove :アラームを削除 

 並び順の変更 :表示順を調整 

 Export/Import :アラーム設定の書き出し・読み込み 

 Options :デフォルトの Acknowledgement Delay（再表示までの待ち時間）を設定 
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◇Add an Alarm（アラームの追加） 
Create an Alarm ウィンドウで以下を設定する。 

 

1. Enable / Disable 

 デフォルトは Enable（有効） 

 Disable(無効)化すると評価されず、発生しない 

 

2. Name（アラーム名） 

 任意の識別名を入力 

 

3. Severity（重大度） 

🔴 Alert 

 Alarm View に表示 

 ステータスバーで点滅 

 必要に応じて Alarm View を自動表示 

 赤色で表示 

🟡 Warning 

 Alarm View に表示 

 ステータスバーで点滅 

 黄色で表示 

🔵 Information 

 Alarm View に表示 

 青色で表示 

 点滅はしない 

 

4. Play Sound（アラーム音） 

 単発音 or アクティブ中の連続音 

 Text to Speech を使う場合はこの項目を有効化する必要がある 

 

5. Alarm Type（アラームタイプ） 

Momentary（瞬時評価） 

条件を常に評価し、条件が成立中はアラームは発生継続。 

 

Set / Reset（セット・リセット型） 

 非アクティブ時:Set 条件を評価し、真になればアクティブへ 

 アクティブ時:Reset 条件を評価し、真になれば非アクティブへ → ラッチ動作が必要な場合に使用 
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6. Alarm Condition（アラーム条件） 

例:Coolant Temp > 80 for 2 [s] 

for 文の仕様 

 「for ○秒」などの 継続時間条件 を指定できる 

 正しい構文: → (Coolant Temp > 80) for 2 [s] 

 単位は秒がデフォルトだが、Quantities and Units にある任意の時間単位が使用可能 

 

7. Acknowledged Wait Period（再表示までの待ち時間） 

アラームを Acknowledge（確認）した後、再び表示されるまでの待ち時間。 

 

注意 :条件が一度 false になり、再び true になった場合、 → 待ち時間中でも再表示されることがある 
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◇Edit an Alarm（アラームの編集） 
Edit an Alarm ウィンドウでは、アラームのすべての設定を変更できます。 

 このウィンドウは Create an Alarm と同じ構造 

 名前、重大度、条件式、Set/Reset、サウンド、Enable など 全項目を編集可能 

 Alarm Setup から既存アラームを → ダブルクリック → または Edit ボタン で開くことができる 

 Alarm View で 発生中のアラームをダブルクリックしても同じ編集画面が開く 

 

◇Remove an Alarm（アラームの削除） 
Alarm Setup ウィンドウで削除したいアラームを選択し、Remove をクリックします。 

 削除は即時反映 

 誤削除を防ぐため、Export でバックアップしておくことも可能 

 必須アラーム（診断系など）は削除不可（※Firmware 側で定義されている場合） 

 

◇Alarms（アラーム）の動作 
M1 Tune では、ユーザー定義のアラームを自由に設定できます。 ECU とオンライン接続中は、アラーム条件が常

に監視され、状態変化がリアルタイムで評価されます。 

 

アラームの通知方法 

アクティブになったアラームは、設定に応じて以下の方法で通知されます: 

 ポップアップウィンドウ 

 サウンド（単発／連続） 

 Text-to-Speech（音声読み上げ） 

 ステータスバーでの点滅表示 
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Alarm Behaviour Overview（アラーム動作の概要） 

アラームは常に次のいずれかの状態にあります 

 
 ＜状態遷移の流れ＞ 

1. Inactive（初期状態） 条件が false のためアラームは発生していない。 

2. Active（条件が true） ECU のオンラインデータに基づき、条件が成立すると Active へ遷移。 

3. Acknowledged（ユーザーが確認） Active のアラームは、ユーザーが Acknowledge するまで 

Inactive に戻らない。 

4. Latched（条件は false だが未確認） 条件が false に戻っても、Acknowledge されるまでは 

Latched 状態で保持される。 

 

Acknowledged 状態と再表示（Re-arm Time） 

Acknowledged 状態のアラームは、設定された “再表示待ち時間（Re-arm Time）” の間は非表示にな

ります。 

＜注意点＞ 

再表示待ち時間中でも再アクティブ化される場合がある 

条件が false → true と再度変化した場合 → Re-arm Time が残っていても再表示される 

これは、アラームが「新たに発生した」と判断されるため。 
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9.2 ALARM SOUND SETUP（アラーム音の設定） 
アラーム音の設定は 2 つの設定から構成されています: 

1. Windows コントロールパネル側のサウンド設定 

Windows の「サウンド」設定に MoTeC M1 Tune Program Event が追加され、ここでアラーム音を割り当てら

れる  

2. Speech -to-text（音声読み上げ） 

 

For Speech-to-Test 
アラーム設定でサウンド再生が選択されている場合、使用される Speech-to-Text（音声読み上げ）の設定は、

Options ウィンドウの Speech セクションで決まります。 

 

 
Speech Settings（音声読み上げ設定） 

Announce Alerts または Announce Warnings のチェックを外すと、音声によるアナウンスは無効になりま

す。 ただし、選択されているサウンドは引き続き再生されます。 

Expansion Rule を使用すると、アラーム名を音声に含めることができます。 例えば、アラーム名が High RPM 

の場合、式が "Alert $(Alarm.Name)" であれば、設定されたサウンドの後に 「Alert High RPM」 が読み

上げられます。 

アイコンを選択すると、式はデフォルト値にリセットされます。 
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For Sounds 
アラーム設定でサウンド再生が選択されている場合、再生されるサウンドは Windows の「サウンド設定」で選

択されたものが使用されます。 

サウンドを変更するには、Options ウィンドウ内のリンクを使用して Windows の「サウンド」ウィンドウを表示しま

す。 

 

         
Alarm Alert と Alarm Warning に使用するサウンドは、Windows のサウンド設定から選択します。 

注記:カスタムサウンドを使用する場合は、任意の .wav ファイル をファイルシステムにコピーすることで利用でき

ます。 
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9.3 HANDLING ALARMS（アラームの表示） 
アラームがアクティブになると、画面下部のステータスバーに表示されます。 以下はその例です: 

  

警告 

 

 

 アラート 

 

 

注意:情報タイプのアラームはステータスバーに表示されません。 

 

Viewing Alarms（アラームの表示） 

発生したアラームを確認するには、サイドバーから Alarms ビュー を選択します。 また、View > Show Alarms 

メニュー、または Shift+F3 でも表示できます。 

 

Alarms Event Log（アラームイベントログ） 
Alert タイプのアラームが発生した際に、Alarms Event Log ウィンドウを自動表示させることができます。 この設定は 

Alarm Setup ダイアログ で選択します。

 

 

 

 

 アラート 1 件 ／ 警告１件 
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Alarm Reset（アラームリセット） 
アラーム条件がすでに false に戻っていても、ユーザーが 確認していない場合、そのアラームは灰色の背景で表示され

ます。 この表示は Alarms Event Log ウィンドウ でも同様です。 

これらのアラームは、次のいずれかが発生するまでこの状態のまま残ります: 

 ユーザーが 確認するまで 

 アラーム条件が再び true と評価された場合

 
 

Acknowledge Alarms（アラームの確認） 
すべてのアラームイベントを消去するには: 

 Active Component Tool Bar の Acknowledge All Alarms を選択します。  

 または、Alarms Event Log ウィンドウ内の Acknowledge All ボタンを選択します。 

 

単一のアラームイベントを消去するには下記のいずれかの方法で行います。 

 アラームバナー上の Acknowledge this alarm を選択します。  

 Alarms Event Log ウィンドウの Real Time タブで、対象のアラームイベントを選択します。 アラーム項目の右側

にある Acknowledge ボタンを選択します。 

 アラーム項目を 右クリックして Acknowledge を選択します。 
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Ignoring Alarms（アラームの無視） 
アラームイベントは無視することができ、無視されたアラームは発生してもステータスバーや Alarms Event Log に表示

されません。 

単一のアラームを無視するには、下記のいずれかの方法で行います。 

 アラームバナー上の Ignore this alarm for the entire session を選択します。  

 Alarms Event Log ウィンドウの Real Time タブで、対象のアラームイベントを選択します。 右クリックして 

Ignore を選択します。 

 

無視されたアラームは、Alarms Event Log ウィンドウの Status タブに移動します。 

   

  
Removing Ignore Status（無視状態の解除） 
Alarms Event Log の Status タブで、対象のアラームを選択します。 アラームを ダブルクリック します。 

これにより、アラームは Real Time タブに戻ります。 

 

Invalid Alarm Items（無効なアラーム項目） 

無効なアラームが作成された場合、そのアラームは Alarms Event Log の Status タブに表示されます。 

無効なアラームの例として、以下が挙げられます: 

 不完全または誤ったアラーム 

 現在の Package で利用できないチャンネルを必要とするアラーム 
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9.4 ALARM LOG AND JUMP TO EVENT 
Alarms Event Log の Log タブには、すべてのアラームイベントの履歴が表示されます。 また、このタブからアラームイ

ベントを Time Graph 上で確認することができます。 

 

  

 

Jump to Event（イベントへのジャンプ） 
イベントへジャンプするには、次の操作を行います: 

1. Pause ボタン を選択して Time Graph を一時停止します。 

2. Log タブで、対象のイベントを選択します。 

3. イベントを ダブルクリック するか、Jump to Event ボタンを選択します。 

これにより、カーソルはイベントが発生した時刻の位置に移動します。 

 

  



 

 

Page  65  

 

 

9.5 ALARM STATUS 
Invalid Alarm Items（無効なアラーム項目） 
無効なアラームが作成された場合、そのアラームは Status タブに表示されます。 

 
 

無効なアラームの例として、以下が挙げられます。 
 不完全または誤ったアラーム 

 現在の Package で利用できないチャンネルを必要とするアラーム 

 

Ignored Alarm Items（無視されたアラーム項目） 
無視状態のアラーム項目はトリガーされず、Real Time タブにもステータスバーの通知にも表示されません。 上の例で

は、High RPM と Oil Pressure のアラームが無視状態になっています。 

無視状態を解除するには、該当項目を ダブルクリック します。 アラームは Real Time タブに戻ります。 

 

  



 

 

Page  66  

 

 

１０．MONITOR 
Monitor View（モニタービュー） 
Monitor View は、リアルタイムデータの監視を目的としたワークスペースです。 このワークスペースでは、Calibrate ウ

ィンドウや Parameter ウィンドウを表示せずに、Time Graph や Gauge を配置・設定できます。 

 
複数ワークシートの構成 
Monitor View では複数のワークシートを構成できます。 さらに、Adjust View で選択したワークシート名と一致する

名前のワークシートが自動的に選択されます。 

 

一般的な使用方法 
Monitor View は、セカンドモニター用のサブウィンドウとして使用するのが一般的なワークフローです。 

 

 
  

Monitor View ボタンを右クリックすると、ウィンドウをセカ
ンダリウィンドウへ移動できます。 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Monitor View ボタンを右クリックすると、プライマリウィン
ドウへ移動するか、ウィンドウを閉じることができます。 
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１１．NOTIFICATIONS 

Notifications View には、以下のような通知が表示されます: 

 現在ロードされている Package の更新情報 

 MoTeC Online から利用可能な Firmware 更新 

 現在の Package に関するエラー（例:ログメモリ割り当てエラー） 

注記:一部の Package エラーは、Package の送信を妨げる場合があります。 

   
 

 Notification Types（通知の種類） 
Notifications View には、最大 9 種類の通知が表示されます。 各通知には、対応するアクションを選択するための

ボタンがあります。 

表示される通知は以下のとおりです: 

1. Package Upgrade Available 

    現在ロードされている Package に対して、アップグレードが利用可能であることを示します。 

2. ECU System Update Available 

    ECU システムの更新が利用可能であることを示します。 

3. Package Save Required または ECU Reset Required （オンライン時にリソース割り当てが変更された場合） 

    Package の保存が必要、または ECU のリセットが必要であることを示します。 

4. Configuration Review Required 

    設定内容のレビューが必要であることを示します。 

5. Configuration Review Tests 

    設定レビューに関連するテストが必要であることを示します。 
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6. Per Cylinder Resource Mismatch 

    各シリンダーのリソース割り当てに不一致があることを示します。 

7. Workspace Template Update Available 

    Workspace テンプレートの更新が利用可能であることを示します。 

8. Workspace Abbreviations Updated 

    Workspace の略語が更新されたことを示します。 

9. Log System Validation Failed または ECU Information Unavailable  

（ECU ログ情報が存在しない場合、例:ECU に一度も接続していない） 

    ログシステムの検証に失敗した、または ECU 情報が利用できないことを示します。 

 

 

 

                                                              ― 以上 ― 

 

 

  


